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Uso del analizador lógico para testear un
dispositivo de lectura de ROMs de Atari 2600

Enunciado de Práctica de Laboratorio
de Circuitos Electrónicos Digitales

IMPORTANTE: La presentación del estudio teórico escrito es obligatoria para la realización 
de la prácticas. Se presentará un estudio por persona y se entregará al 
profesor durante la sesión de prácticas. El estudio ha de dar respuesta a cada
una de las cuestiones y ha de ser detallado, completo, claro y bien 
presentado. El profesor podrá realizar preguntas o pedir aclaraciones sobre el
estudio teórico realizado. Además cada alumno debe llevar impreso el 
enunciado.

1. Introducción

El  analizador  lógico  es  un  instrumento  de  laboratorio  que  facilita  enormemente  el  testado  de

circuitos y sistemas digitales que poseen un alto número de entradas y salidas como, por ejemplo, las

memorias de acceso directo.  Al igual que el osciloscopio, el analizador lógico mide señales de tensión,

pero entre ambos existen importantes diferencias:

▪ El osciloscopio puede medir  simultáneamente un número reducido de señales (usualmente 2),

mientras que analizador puede leer multitud de ellas (del orden de decenas). El analizador mide

cada señal mediante un cable que está asociado a un canal.

▪ El osciloscopio mide niveles continuos de tensión, mientras que el analizador lógico sólo establece

si  las  señales  están  por  encima  o  por  debajo  de  un  determinado  umbral.  De  esta  forma  el

analizador puede indicar el valor lógico de una señal (0 ó 1), pero no puede concretar su nivel

exacto de tensión.

▪ El osciloscopio monitoriza y representa continuamente las señales. El analizador, por el contrario,

sólo examina las señales en ciertos instantes de tiempo para registrar su valor lógico en una

memoria interna (la acción de leer y registrar el valor lógico de las señales se denomina captura).

El analizador sólo puede informarnos del valor lógico que tienen las señales en los instantes de

captura.
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Los analizadores pueden realizar las capturas espaciadas en el tiempo en un periodo seleccionable, para

lo que disponen de un reloj interno. No obstante, también pueden configurarse para que realicen las

capturas cuando ocurra un flanco en una entrada especial (la entrada de reloj externo). Además pueden

configurarse para que empiecen a registrar los datos al detectar un determinado patrón en los canales

de datos (a este patrón se le denomina palabra de disparo). Todo esto convierte al analizador en una

herramienta ideal para analizar el funcionamiento de buses digitales.

En nuestro laboratorio disponemos de analizadores lógicos sobre PC, esto es, una tarjeta de adquisición

y un programa sobre PC que funcionan como tal analizador, concretamente el modelo LA-2132. En la

presente  práctica  se  usará  dicho  analizador  para  estudiar  el  proceso  de  lectura  de  una  ROM,  en

concreto la ROM de un cartucho de la videoconsola Atari 2600. Dichas ROMs tienen una capacidad de

4KBytes, esto es, 2¹²x8 bits. En el laboratorio se realizará una lectura de todas sus 4K posiciones de

memoria. Esto se consigue generando todas las posibles direcciones de memoria, desde 0 hasta 4095

($000 a $FFF en hexadecimal). Para ello se usará un contador de 12 bits construido conectando en

cascada tres contadores comerciales 74191 tal y como se muestra en la figura 1. Dichos contadores son

disparados por el flanco de subida (véase el anexo de la última página).

Figura 1. Conexionado de la placa

Usaremos  el  analizador  lógico  para  observar  las  señales  digitales  del  circuito.  La  conexión   del

analizador a la placa del circuito se hace a través de unas sondas o cables. El analizador lógico opera en

dos fases:  primero,  adquiere  el  valor lógico de las  señales  y  los  almacena en su  memoria interna;

después, representa estos valores en un monitor mediante una herramienta que facilita los recursos de

visualización y medida de tiempos. Además, el analizador permite salvar los datos capturados en un

fichero.

P1
Q

11
Q

01
CE
U

/D
Q

21
Q

31
G

N
D

V
CC
P0CP
RCTCPLP2P3

P1
Q

10
Q

00
CE
U

/D
Q

20
Q

30
G

N
D

V
CC
P0CP
RCTCPLP2P3

A7
A6
A5
A4
A3
A2
A1
A0

VCC
A8
A9
OE
CS
A10
A11
O7
O6
O5
O4
O3

D6
D5
D4
D3
D2
D1
D0

D7

VCC GND

CLK

GND

VCC

Q32
Q22
VCC

Q12
Q02

Q31
Q21
Q11
Q01
Q30
Q20
Q10
Q00

74191-1
74191-0

ROM

VCC

O0
O1
O2

GND

A7
A6
A5
A4
A3
A2
A1
A0

Figura 1 Conexionado de la placa

A11
A10
A9
A8

P1 Q
12

Q
02 CE U
/D

Q
22

Q
32

G
N

D

V
CC P0 CP RC TC PL P2 P3

74
19

1-
1

G
N

D

V
CC

V
CCG

N
D

G
N

D
G

N
D

G
N

D

V
CC

V
CC

G
N

D

V
CC

V
CC

G
N

D
G

N
D

CLK



Estructura de Computadores  3

2. Objetivos

Los objetivos generales de esta sesión de laboratorio son los siguientes:

▪ Introducir el manejo del analizador lógico.

▪ Realizar el testado a nivel lógico de un sistema digital sencillo, en concreto una placa diseñada

para leer ROMs de juegos de Atari 2600.

▪ Realizar un volcado de la ROM y comprobar experimentalmente la corrección del procedimiento

mediante el uso de un emulador de Atari 2600.

▪ Medir, de forma aproximada, tiempos de propagación y frecuencias máximas de operación del

circuito.

3. Estudio teórico

Debe estudiar y comprender el funcionamiento del circuito de la figura 1a (el componente 74191 se

describe en el anexo de la última página) y, responder las siguientes cuestiones:

1. Suponga que los contenidos de las tres posiciones de ROM más bajas ($000, $001 y $002) son

respectivamente $37, $A9 y $7E, y que el contenido de la posición de memoria más alta es $00.

Considere  $FFF  como  estado  inicial  del  contador.  Suponiendo  que  tanto  la  ROM  como  los

contadores tienen un retraso nulo, complete el siguiente cronograma:

2. Para  el  cronograma  anterior,  suponga  que  el  analizador  lógico  captura  las  señales  a  una

frecuencia cuatro veces superior a la del reloj de la placa y que la primera se realiza en el instante

marcado por la flecha. Marque sobre el cronograma cuándo se realizarían el resto de las capturas

y escriba en una tabla los valores de las líneas de datos y dirección en cada una de ellas.

3. Vuelva a completar el cronograma siguiente suponiendo ahora que el conjunto de contadores tiene

un retraso Rc>0, la ROM un retraso Rr>0 y asumiendo que la suma de ambos retrasos es menor a

la mitad del periodo de reloj de la placa (es decir, debe suponer R c+Rr < Tp/2, donde Tp es el

periodo de reloj de la placa). No olvide marcar los retrasos sobre el cronograma.

RELOJ DE LA PLACA

LÍNEAS DE DIRECCIÓN

LÍNEAS DE DATOS

$FFF

primera captura

RELOJ DE LA PLACA

LÍNEAS DE DIRECCIÓN

LÍNEAS DE DATOS

$FFF
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4. Para el cronograma anterior, indique en una tabla los valores de las líneas de dirección y datos

que leería el analizador lógico si realiza las capturas  en los flancos de bajada del reloj de la placa.

5. Vuelva a completar el cronograma siguiente suponiendo ahora que ambos retrasos son menores

que la mitad del periodo, pero que su suma no lo es (Rc < Tp/2, Rr < Tp/2, Rc+Rr > Tp/2). No olvide

marcar los retrasos sobre el cronograma.

6. Para el cronograma anterior, escriba en una tabla los valores de las líneas de dirección y datos

que leería el analizador lógico si realiza las capturas en los flancos de bajada del reloj de la placa.

7. Para el cronograma anterior, escriba en una tabla  los valores de las líneas de dirección y datos

que leería el analizador lógico si realiza las capturas en los flancos de subida del reloj de la placa.

4. Estudio experimental

La realización del  estudio  experimental  requerirá  los  siguientes  componentes:  Analizador  lógico,

generador de ondas, osciloscopio, fuente de continua, placa de circuito impreso (el lector de ROMs de

Atari 2600) y de cartucho de Atari 2600. El osciloscopio se usará únicamente para comprobar las señales

de reloj y la alimentación.

4.1. Montaje y conexión con el instrumental.

La disposición aproximada de los distintos componentes y conectores de la placa con los contadores

se muestra en la figura 2a, aunque puede variar ligeramente de un modelo a otro. En la placa aparecen

los siguientes componentes:

▪ Un conector donde ha de conectarse la placa con la ROM de Atari 2600. La ROM estará siempre

activa, de manera que en su salidas (señales de D0 hasta D7) aparece siempre el contenido de la

palabra direccionada.

▪ Tres contadores de 4 bits (C.I. 74191) que están conectados en cascada formando un contador

módulo 4096. Sus 12 bit de salida constituyen la entrada de dirección de la ROM.

▪ Un conjunto de puntos de conexión para la alimentación, la señal de reloj, las de fin de ciclo (FC2,

FC1 y FC0) y las lineas de dirección y datos de la ROM. Con ellos se pueden conectar con facilidad

las sondas del analizador lógico a las señales de interés.

RELOJ DE LA PLACA

LÍNEAS DE DIRECCIÓN

LÍNEAS DE DATOS

$FFF
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Antes de alimentar la placa con la fuente de continua debe hacerse lo siguiente:

1. En primer lugar se extraerá la placa con la ROM del cartucho y se insertará en el zócalo del

circuito de lectura. ES MUY IMPORTANTE NO INSERTARLA AL REVÉS: La cara con el chip de la

ROM debe estar orientada hacia los pines de datos D0-D7.

2. A continuación se conectarán los terminales del circuito bajo test a las sondas del analizador que,

por otro lado, deberá conectarse al ordenador a través del puerto USB. El orden de las conexiones

de los terminales del analizador a la placa se muestra en la tabla de la figura 2b. Solo se usará uno

de los terminales de tierra, los canales del 0 al 22 y el canal 31. Este último es el único que puede

usarse para disparar la captura por flanco de una señal externa de reloj.

3. Use el generador de ondas para generar la señal de reloj. Debe ser una señal cuadrada de 25 Khz

de frecuencia que varíe entre 0 y 5 voltios. Además deberá tener un duty cycle del 50%, es decir,

durante cada ciclo deberá encontrarse la mitad del tiempo en nivel alto y la otra mitad en nivel

bajo. Tendrá que emplear el osciloscopio para comprobar si la señal es correcta.

4. Use el  generador de continua para generar la señal  de alimentación de 5 voltios.  No use el

generador de tensión fija.

5. Baje el limitador de intensidad (sin situarlo completamente a la izquierda, es decir, a las 9 si fuera

la manilla de un reloj).

6. Use el osciloscopio para chequear si la alimentación es de 5 voltios.

Sólo después de haber realizado los pasos anteriores deberá conectar la alimentación y la señal de reloj

a la placa.  Tras esto la ROM estará mostrando cíclicamente en su salida el  contenido de todas sus

posiciones de memoria.

Terminal del analizador Color del cable Terminal de la placa
Canal 0 marrón D0
Canal 1 rojo D1
Canal 2 naranja D2
Canal 3 amarillo D3
Canal 4 verde D4
Canal 5 azul D5
Canal 6 magenta D6
Canal 7 gris D7
Canal 8 marrón A0
Canal 9 rojo A1

Canal 10 naranja A2
Canal 11 amarillo A3
Canal 12 verde A4
Canal 13 azul A5
Canal 14 magenta A6
Canal 15 gris A7
Canal 16 marrón A8
Canal 17 rojo A9
Canal 18 naranja A10
Canal 19 amarillo A11
Canal 20 verde FC0
Canal 21 azul FC1
Canal 22 magenta FC2

GND negro GND
Canal 31 gris CLK

(a) (b)

Figura 2. (a) Distribución de los componentes y conectores, (b) Tabla de conexión.
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4.2. Configuración del analizador LA-2132 para chequear el circuito

Hay  que  tener  en  cuenta  que  antes  de  ejecutar  el  software  del  LA-2132  debemos  conectar  el

analizador al puerto USB del PC. Este software, disponible en Windows, se ejecuta pulsando sobre el

icono CLK disponible en el escritorio. 

A grandes rasgos, la ventana de aplicación presenta un marco superior que contiene los distintos menús

(File,  View,  Timing,...), una fila de comandos u opciones que se pueden ejecutar (Go,  Stop, ....) y una

ventana dividida en dos partes (ver figura 3): 

▪ La parte superior contiene los controles de los cursores/marcadores del sistema, los controles de

zoom y una barra para desplazarnos a lo largo de las capturas.

▪ La  parte  inferior  está  dedicada  a  presentar  los  datos  capturados  en los  distintos  canales  de

adquisición. 

Antes de adquirir y visualizar las señales de la placa debemos configurar los parámetros de captura.

Para ello si pulsamos con el botón derecho sobre la ventana inferior (Timing view 1), debe aparecer una

ventana emergente llamada Parameters como la mostrada en la figura 3. 

Figura 3. Condiciones de trabajo.

En la ventana Parameters recién aparecida, seleccionamos las siguientes opciones:

▪ En la entrada Trig Word (en la que aparecen los canales en el orden 31, 30, 29, .., 0), escribimos

‘1’  en  las  posiciones  correspondientes  a  los  canales  20,  21  y  22,  es  decir,  los  canales

correspondientes a las señales de fin de cuenta. Esto servirá para indicar al analizador cuando

debe comenzar a capturar muestras (el estado de cuenta es $FFF si las tres señales valen 1).
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▪ Para establecer que la adquisición de datos vaya sincronizada con el flanco de bajada del reloj

externo (el de nuestra placa), seleccionamos External falling en la entrada Source.

▪ Para que el tamaño de la captura sea de 8K muestras seleccionamos 8K en la entrada Memory.

▪ Para que realice una sola captura seleccionamos Single en la entrada Acquire.

Tras esto cerramos la ventana  Parameters. Si dejamos la configuración tal y como está, el analizador

comenzará a capturar cuando las tres señales de fin de cuenta valgan uno, es decir, cuando en las líneas

de dirección haya $FFF. A nosotros nos interesa más que empiece a capturar cuando la dirección pase a

valer $000,  es decir,  justo cuando la  condición de disparo pase de ser cierta a ser falsa.  Para ello

pulsamos en la opción  Trigger del menú principal y, en la ventana recién aparecida llamada  trigger,

cambiamos en la  fila  Level 0 la  opción marcada como  Enter a  Exit.  Tras esto cerramos la ventana

trigger.

El  siguiente paso es establecer la agrupación de

canales.  Usando  el  menú  View → Group  edit.

aparecerá la ventana Group Setup mostrada en la

figura 4.

Esta ventana permite establecer varios grupos de

canales.  Para  cada  grupo  de  canales  hay  que

establecer su nombre (entrada  Name), la base en

la  que  se  visualizará  el  valor  de  sus  canales

(entrada  Base),  el  número  de  canales  que  lo

forman  (entrada  Number1)  y  cuáles  son  dichos

canales  (entrada  Channel  combination).  Para

cambiar de grupo se pulsa sobre las flechas de la

parte superior de la ventana. 

Se crearán cuatro grupos y debe utilizar la tabla mostrada en la figura 2b para hacerlo correctamente.

Los grupos son los siguientes:

1. El grupo 0, que llamaremos contenido, estará constituido por los canales del 0 al 7, que estarán

conectados a la salida de la ROM. Deberá mostrarse en hexadecimal. 

2. El grupo 1, llamado dirección estará constituido por los 12 bits correspondientes a las entradas de

dirección de la ROM y se mostrará también en hexadecimal.

3. El grupo 2, llamado Fin Cuenta contendrá las señales de fin de cuenta de cada uno de los tres

contadores (FC0, FC1 y FC2) y se mostrará en binario.

4. El grupo 3 y último grupo, llamado reloj, contendrá únicamente la señal de reloj de la placa (canal

31) y se mostrará en binario.

Como ejemplo2, la figura 5 muestra como quedaría la ventana  Group Setup tras configurar el grupo 2.

1 En la versión para Windows 7 y Windows 10 del software del analizador incluye un fallo que obliga a introducir en la entrada 
Number el número de canales menos uno.

2 El ejemplo es para la versión del software sin el fallo. En la versión para Windows 7 y Windows 10 habría que introducir 2 en la 
entrada Number.

Figura 4. Agrupación de canales.
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Ahora pasamos a la adquisición de los datos. Para ello pulse el botón GO y comenzará la adquisición al

ritmo marcado por el reloj. Tras finalizar la adquisición aparecerán actualizados los datos capturados en

la pantalla. Con la configuración señalada se capturarán las señales en cada flanco de bajada del reloj

externo. Para comprobar si la captura es correcta, compruebe lo siguiente:

▪ El valor de las líneas de dirección (canales del 8 al 19), al ser la salida de un contador controlado

por el mismo reloj que dispara las capturas, debe incrementarse en cada muestra. Sus formas de

onda deben ser señales cuadradas, cada una de ellas de periodo doble a la anterior. Para verlo con

claridad conviene ampliar la representación de las formas de onda aumentando el  valor de la

opción Magnify.

▪ Las  tres  señales  de  fin  de  cuenta  se  pondrán  simultáneamente  a  uno  únicamente  cuando  el

contador esté en el último estado de cuenta.

Además, se debe comprobar si en las líneas de datos aparece, de forma secuencial, el contenido de cada

posición de la ROM. Dado que se trata de una ROM de Atari 2600, esto puede comprobarse guardando

los datos capturados y pasándolos a un emulador de la forma descrita a continuación:

1. Guardaremos las capturas del analizador en un fichero haciendo lo siguiente:

1.1. En el menú del software del analizador seleccionamos File → Save data → Save data as.

2. Seleccionamos la carpeta3 del disco local  C:\Users\practicas para grabar las capturas pulsando

sobre el icono Mi PC y elegimos como nombre de archivo captura. Al pulsar Guardar se creará el

fichero captura.dso en dicha carpeta.

3 En Windows 7 y Windows 10 podemos tener problemas si intentamos escribir directamente en la carpeta raíz.

Figura 5. Configuración del grupo de canales 2.
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3. Ahora debemos extraer de dicho archivo los valores  correspondientes a las  líneas de datos y

grabarlos en un fichero binario legible por el emulador de la forma siguiente:

3.1. Abrimos una ventana de línea de comandos. Esto puede hacerse de varias formas:

▪ En Windows XP y Windows 7 accediendo al menú de inicio de Windows (Inicio→

Todos los programas → Accesorios → Símbolo del sistema).

▪ En  Windows  10  pulsando  con  el  botón  derecho  sobre  el  menú  Inicio y  luego

seleccionando WindowsPowerShell, o bien buscar y ejecutar el comando cmd.

3.2. Introduzca lo siguiente en la líne de comandos:

La primera orden establece la carpeta sobre la que trabajaremos y la segunda extrae del fichero

captura.dso los  datos  correspondientes  al  contenido  de  la  ROM  y  los  escribe  en  el  fichero

juego.bin.

4. Finalmente comprobaremos el volcado con el emulador Stella. Para ello:

4.1. Se pulsa sobre el icono Stella en el escritorio.

4.2. Dentro del emulador se hace doble click sobre el fichero juego.bin previamente creado.

4.3. Se comprueba que en efecto el programa de Atari funciona. Las teclas básicas son F2 (start,

comienzo de partida), espacio (disparo), y los cursores.

cd c:\users\practicas
dso2bin captura.dso juego.bin
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4.3. Comprobación del estudio teórico

1. Para ver el listado de muestras seleccione View → State of logic analyzer. Pulse sobre el botón T

situado a la izquierda de las muestras para situarse en la muestra donde se produjo el disparo.

Apunte algunas de las direcciones de memoria que aparecen en la pantalla (en particular la $000),

así como el contenido correspondiente.

2. Cambie el modo de adquisición de datos en el analizador lógico para que realice las capturas a

una frecuencia cuatro veces superior a la del reloj de la placa. Para ello abra de nuevo la ventana

Parameters, seleccione Internal en la entrada Source y 100KSa(10us) en la entrada Rate  (100 Ksa

denota 100 Kilo Samples, es decir cien mil muestras que se tomarán cada segundo, de modo que

estarán  espaciadas  10  μsegundossegundos).  Verifique  experimentalmente  su  respuesta  al  punto  2  del

estudio teórico (mueva el cursor Trigger para ver cuántas veces se repite cada muestra).

3. Cambie la frecuencia de muestreo del analizador a  250MSa(4ns) y vuelva a capturar.  Use los

cursores para medir aproximadamente el retraso del contador de 12 bits (Rc) y de la ROM (Rr).

4. Para verificar experimentalmente las respuestas a los puntos 5 y 6 haga lo siguiente:

4.1. Cambie de nuevo el  modo de adquisición de datos para que la captura se realice en los

flancos de bajada del reloj de la placa seleccionando External falling en la entrada Source de la

ventana Parameters. Además, para que el analizador realice cíclicamente capturas sin detenerse

selecione Auto en la entrada Acquire de la ventana Parameters.

4.2. Pulse GO para iniciar las capturas y aumente poco a poco la frecuencia del reloj de la placa

justo hasta que los datos anotados en el apartado 1 no se capturen correctamente.

4.3. Calcule el periodo del reloj de la placa y compruebe si se cumple la desigualdad del apartado

6 del estudio teórico.

5. Cambie de nuevo el modo de adquisición de datos para que la captura se realice en los flancos de

subida del reloj  de la placa seleccionando  External rising en la entrada  Source de la ventana

Parameters.  Use  los  datos  anotados  en  el  apartado  1  para  verificar  experimentalmente  su

respuesta al punto 7 del estudio teórico.

Anexo: descripción del contador comercial 74191

El componente 74191 es un contador de 4 bits. A parte de sus salidas de estado (Q) y sus entradas de

datos para carga en paralelo (P) dispone de las siguientes señales:

▪ CE (Count Enable, entrada): es la señal de habilitación de cuenta (activa en bajo).

▪ U/D (Up/Down, entrada): indica si la cuenta será ascendente (valor 0) o descendente (valor 1).

▪ CP (Clock Pulse, entrada): es la señal de cuenta y es activa en el flanco de subida.

▪ TC (Terminal Count, salida): indica el fin del ciclo de cuenta (se activa en el estado 1111).

▪ RC (Ripple Clock, salida): Si CE está activada y el contador está en el último estado de cuenta es

igual a CP. En cualquier otro caso vale 1.

▪ PL (Parallel Load, entrada): Cuando vale cero el contador realiza una carga asíncrona en paralelo.


